Pocetak rada u Excelu

U ovom delu pronaci ¢ete osnovne informacije o Excelu i
nauciti da radite s njegovim najvaznijim alatkama. Ako ste
vec koristili Excel (ili neki drugi program za tabelarne prora-
Ccune), veci deo ove celine bice obnavljanje znanja. Cakidaje
tako, sigurni smo da cete ovde pronaci poprilican broj korisnih
trikova i tehnika za rad u Excelu”.

* Primeri u ovoj knjizi prilagodeni su nasim standardima za pisanje bro-
jeva, valuta, datuma i vremena, kao i za nabrajanje. Mnogi primeri nece
raditi ukoliko vas operativni sistem i Excel ne podesite na isti nacin.

U Excelu izaberite Tools &> Options i na kartici International proverite
dali je potvrdena opcija Use System Separators. Ukoliko koristite Win-
dows XP, u Control Panelu izaberite Regional and Language Options
(Regional Settings na Windowsu 2000/98/ME) i zatim na kartici Regional
Options izaberite Serbian (Latin) u padajucoj listi Standards and for-
mats (ista padajuca lista u Windowsu 2000 nalazi se na kartici General).
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POGLAVLIJE

Uvod u Excel )

U ovom poglavlju daje se uvodni pregled Excela, namenjen

korisnicima koji nemaju iskustva u radu s njim. Cak i ako ste . . . .
iskusan korisnik Excela, mozda ¢ete ovde pronaci i neSto novo. .
Ukoliko prelazite sa verzije 2002 na verziju 2003, bice vam kori- U ovom poglavlju

stan kratak pregled novih mogucnosti. ;
Sta je Excel

Sta je Excel

. . . Upotreba Excelovih
Verovatno vec i sami znate da je Excel program za tabelarne P

menija, paleta alatki

proracune, koji se isporucuje kao deo paketa Microsoft Office. i okvira za dijalog
Postoje i drugi sli¢ni programi, ali je Excel zasad najpopularniji.
Jedna od najvecih prednosti Excela jeste to Sto ima viSe Kretanje po radnim
namena. Njegov osnovni zadatak su numericka izracunavanja, ali listovima
je vrlo koristan i u nenumerickim primenama. NaveS¢emo neko-
liko nacina za koriS¢enje Excela: Primer: izrada radnog
lista

¢ Obrada numerickih podataka Izrada proracuna, analiza
rezultata, kao i mogucnost bilo kog tipa finansijske analize ¢ ¢ ¢ ¢
koji moZete da zamislite.

¢ lIzrada dijagrama Mogucnost Izrade Sirokog spektra dija-
grama koji se mogu prilagodavati potrebama korisnika.

¢ Organizovanje spiskova Upotreba redova i kolona za
efikasno memorisanje spiskova.

¢ Pristup drugim podacima Uvoz podataka iz raznih izvora.

¢ lzrada slika i dijagrama Upotreba alatke Excel AutoSha-
pes za izradu jednostavnih (ali i sloZenijih) dijagrama.

¢ Automatizovanje sloZenih zadataka Efikasno obavljanje
zadataka jednim pritiskom tastera misa.

Radne sveske i radni listovi
Sve ono §to radite u Excelu smeSta se u datoteke koje nazivamo
radnim sveskama (engl. workbook). Radne sveske se prikazuju u
zasebnim prozorima i moZete ih otvoriti onoliko koliko Zelite.
Nastavak imena datoteke radnih svezaka je XLS.

Svaka radna sveska sastoji se od jednog ili viSe radnih listova
(engl. worksheet), a svaki radni list se sastoji od pojedina¢nih
celija (engl. cell). Celije sadrze vrednosti, formule ili tekst. Rad-
nom listu moZete pristupiti ako pritisnete jezi¢ak lista na dnu
radne sveske. U radnoj svesci mogu se cuvati i listovi sa dija-
gramima. List sa dijagramom prikazuje jedan dijagram i takode
mu se moze pristupiti pomocu jezicka lista.
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Deo | ¢ Poéetak rada u Excelu

Novi korisnici €esto su uplaseni mnogobrojnim elementima Excelovog prozora.
Medutim, ubrzo c¢ete nauciti Sta svaki od njih radi i uvideti da ih uopste nije teSko

razumeti.

Slika 1-1 prikazuje najvaznije elemente Excela. Dok posmatrate stavke na slici,
pratite njihova objasnjenja u tabeli 1-1.

Tabela 1-1 Delovi Excelovog prozora koje morate znati

Naziv

Opis

Indikator aktivne celije

Dugme za zatvaranje aplikacije
Dugme za zatvaranje prozora
Zaglavlja kolona

Polje za formule
Horizontalna klizna traka

Dugme za maksimiranje / vracanje
na prethodnu veli¢inu

Linija menija

Dugme za minimiziranje aplikacije
Dugme za minimiziranje prozora
Polje za ime

Zaglavlja redova

Jezidci listova

Dugmad za pomeranje jezitaka
listova

Statusna traka

Okno za poslove

Bira¢ okna za poslove

Naslovna traka

Palete alatki

Vertikalna klizna traka

Ovaj taman okvir oko ¢elije ozna¢ava da je ona aktivna (jedna
od 16.777.216 Celija, koliko ih ima na svakom radnom listu).

Kada pritisnete ovo dugme, zatvarate Excel.
Kada pritisnete ovo dugme, zatvarate prozor aktivne radne sveske.

Niz slova od A do IV - po jedno za svaku od 256 kolona na
radnom listu. Posle kolone Z sledi kolona AA, zatim AB, AC itd.
Posle AZ dolazi kolona BA, BB... sve do poslednje oznacene sa IV.
Kada pritisnete zaglavlje kolone, izabrali ste celu kolonu.

Kada unesete podatke ili formule u Excel, oni se prikazuju u ovom
polju.

Omogucava horizontalno pomeranje sadrzaja radnog lista.

Kad pritisnete ovo dugme, prozor radne sveske ce se povecati tako
da ispuni ceo Excelov radni prostor. Ako je prozor ve¢ povecan, a vi

pritisnete ovo dugme, Excelov prozor cete vratiti na prvobitnu
veli¢inu (tako da ne ispunjava ekran).

Ovo je Excelov glavni meni. Kad pritisnete neku njegovu stavku,,
pojavice se padajuca lista komandi koje moZete da zadate Excelu.

Ako pritisnete ovo dugme, smanjujete Excelov prozor.
Ako pritisnete ovo dugme, smanjujete prozor radne sveske.

Prikazuje adresu aktivne Celije, ili ime izabrane celije, podrugja ili
objekta.

Niz brojeva od 1 do 65.536, po jedan za svaki red na radnom listu.
Ako pritisnete zaglavlje reda, izabracete ceo red.

Svaki od ovih jezi¢aka, poput onih u adresaru, predstavlja jedan
radni list u radnoj svesci. Broj listova u radnoj svesci nije odreden,
a svaki list ima jezi¢ak sa svojim imenom. Svaka nova radna sveska
podrazumevano ima tri radna lista.

Pomocdu ove dugmadi pomerate jezitke listova da biste dosli do
onih radnih listova ciji se jezicci ne vide.

Na ovoj traci se pojavljuju razne poruke, kao i stanje tastera Num
Lock, Caps Lock i Scroll Lock.

Ovaj okvir prikazuje opcije zadatka koji obavljate.

Pomocu njega birate razli¢ita okna za poslove tako da mozete
da otvarate radne sveske, koristite Officeov Clipboard ili radite
s podacima formata XML.

Svi Windowsovi programi imaju naslovnu traku, na kojoj su
prikazani ime programa i neka kontrolna dugmad koju koristite
za podes$avanje prozora.

Pomocu dugmadi na paletama alatki zadajete komande Excelu.
Neka dugmad prikazuju dodatnu dugmad kad ih pritisnete.

Omogucava vertikalno pomeranje sadrZaja radnog lista.
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Poglavlje 1 ¢ Uvod u Excel 5

Dugme za zatvaranje prozora
Dugme za zatvaranje aplikacije

Dugme za vracéanje na prethodnu veli€inu

Zaglavlja redova Dugme za minimiziranje aplikacije
Indikator aktivne ¢elije Linija menija Dugme za minimiziranje prozora

Polje zaime | Polje za formule | Naslovna traka Zaglavlja kolona Palete alatki
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Jeziccilistova  Statusna traka Horizontalna Okno za poslove
klizna traka
Dugmad za pomeranje Vertikalna klizna traka  Bira¢ okna za poslove

jezicaka listova

Slika 1-1: Excelov prozor sadrzi korisne elemente koji se ¢esto upotrebljavaju.

Kretanje po radnom listu
U ovom odeljku opisujemo kako se moZete kretati od jedne do druge ¢elije u rad-
nom listu.

Svaki radni list se sastoji od redova (obeleZenih brojevima od 1 do 65536) i kolona
(oznacenih slovima od A do IV). Posle kolone Z dolazi kolona AA, posle AZ — BA itd.
Presek reda i kolone je jedna celija. U bilo kom trenutku samo jedna ¢elija mozZze biti
aktivna. Nju cete prepoznati po tamnom okviru, kao Sto je prikazano na slici 1-2.
Njena adresa (slovo njene kolone i broj njenog reda) pojavljuju se u polju za ime.
Dok se krecete kroz radnu svesku, aktivna celija moZze, ali i ne mora da se menja,
Sto zavisi od tehnike koju koristite za kretanje.
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Slika 1-2: Aktivna ¢elija je ona s tamnim
A ] = ] £ 7| okvirom — u ovom sluéaju, ¢elija C14.
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Aktivna celija

Zaglavlja reda i kolone aktivne celije prikazani su drugacijim bojama, sto omogucava da je
lakse prepoznate.

Kretanje pomocu tastature

Kao Sto verovatno vec znate, za kretanje po radnom listu moZete da koristite stan-
dardne tastere sa strelicama. One rade kao §to oCekujete: strelica nadole pomera
aktivnu €eliju za jedan red niZe, strelica nadesno pomera je za jednu kolonu desno
itd. Tasteri PgUp i PgDn pomeraju aktivnu celiju za ceo prozor gore ili dole (broj
redova za koje ce se Celija pomeriti zavisi od broja redova koji su prikazani u pro-
zoru).

Ako ukljucite taster Scroll Lock, moZete da pomerate sadrzaj radnog lista na ekranu, a da
pri tome ne menjate aktivnu celiju. Ovo je korisno ako treba da pogledate drugi deo rad-
nog lista, a zatim se brzo vratite na prvobitno mesto. Pritisnite taster Scroll Lock i onda se
pomocu tastera sa strelicama krecite po radnom listu. Kad hocete da se vratite na po¢etnu
poziciju (aktivnu celiju), pritisnite Ctrl+Backspace. Zatim ponovo pritisnite Scroll Lock da
biste ga iskljucili. Kad je ova funkcija uklju¢ena, Excel na statusnoj traci na dnu prozora
prikazuje skracenicu SCRL.

Taster Num Lock kontroliSe ponaSanje tastera na numerickoj tastaturi. Kada je
ukljucen, Excel na statusnoj traci prikazuje skracenicu NUM, a tasteri na numerickoj
tastaturi daju brojeve. Vecina tastatura ima poseban skup tastera sa strelicama,
levo od numericke tastature. Na te tastere ne utiCe status tastera Num Lock.

U tabeli 1-2 dat je pregled svih Excelovih tastera za kretanje po radnom listu.

Tabela 1-2 Tasteri za kretanje po Excelovom radnom listu

Taster Komanda

Strelica nagore Pomera aktivnu celiju za jedan red navise
Strelica nadole Pomera aktivnu celiju za jedan red nanize
Strelica ulevo Pomera aktivnu celiju za jednu kolonu ulevo
Strelica udesno Pomera aktivnu celiju za jednu kolonu udesno
PgUp Pomera aktivnu celiju za jedan ekran navise
PgDn Pomera aktivnu celiju za jedan ekran nanize

FN2RR liine 2 2004 110 nm



Savet

Poglavlje 1 ¢ Uvod u Excel 7

Tabela 1-2 Tasteri za kretanje po Excelovom radnom listu (nastavak)

Taster Komanda

Alt+PgDn Pomera aktivnu ¢eliju za jedan ekran udesno

Alt+PgUp Pomera aktivnu celiju za jedan ekran ulevo

Ctrl+Backspace Pomera sadrZaj tako da se vidi aktivna celija

Strelica nagore” Pomera ekran za jedan red navise (aktivna celija se ne menja)
Strelica nadole” Pomera ekran za jedan red nanize (aktivna celija se ne menja)
Strelica ulevo” Pomera ekran za jednu kolonu ulevo (aktivna celija se ne menja)
Strelica udesno” Pomera ekran za jednu kolonu udesno (aktivna ¢elija se ne menja)

* Sa uklju¢enim tasterom Scroll Lock

Kretanje pomocu misa

Da biste promenili aktivnu celiju pomoc¢u miSa, postavite pokazivac¢ na neku drugu
Celiju, pritisnite taster misa i ta celija ¢e postati aktivna. Ako se celija koju Zelite da
aktivirate ne vidi u prozoru radne sveske, pomocu kliznih traka moZete da pome-
rate radni list u bilo kom pravcu. Da biste ga pomerili za jednu €eliju, pritisnite
odgovarajucu strelicu na kraju klizne trake. Da biste pomerili prozor za ceo ekran,
pritisnite prostor na kliznoj traci pored dugmeta za pomeranje sadrzaja sa odgo-
varajuce strane. MoZete i da povlacite to dugme da bi se sadrZaj brZze pomerao.

Da biste vertikalno pomerali sadrzaj mozete da koristite i tocki¢ ukoliko ga vas mi$ ima. Ako
pritisnete tockic i pomerite misa u bilo kom pravcu, radni list ¢e se automatski pomerati u
istom pravcu. Sto vise budete pomerali mi$a, to ¢e se sadrZaj brze kretati. Ako vise volite da
tockic¢ misa koristite za zumiranje radnog lista, izaberite komandu Tools => Options, otvorite
karticu General i upisite znak za potvrdu u polje Zoom on roll with IntelliMouse.

Ako sadrzZaj pomerate pomocu kliznih traka, ili pomoc¢u miSa s tocki¢em, necete
pomeriti aktivnu celiju. Tako se samo pomera sadrZaj. Da biste aktivirali neku drugu
Celiju, nakon Sto pomerite sadrZzaj morate je pritisnuti.

Excelovi meniji i palete alatki

Ako ste koristili druge programe, lako cete koristiti i Excel. Njegovo korisnicko
okruZenje (odnosno, meniji i palete alatki) radi na isti nacin kao i okruZenja drugih
programa.

U mnogim sluc¢ajevima, jednu komandu moZete zadati na viSe nacina. Na primer,
ako hocete da snimite ono §to ste radili, moZete da upotrebite meni (komanda File
= Save), priru¢ni meni (pritisnite naslovnu traku radne sveske desnim tasterom
miSa i izaberite Save), dugme s palete alatki (dugme Save na paleti Standard) ili
precicu s tastature (Ctrl+S). Sta cete izabrati zavisi od vas.

Upotreba menija

Kao i ostali Windowsovi programi, i Excel ima liniju menija smeStenu odmah ispod
naslovne trake (slika 1-3). Ona vam je uvek na raspolaganju. Excelovi meniji se
menjaju u zavisnosti od toga Sta upravo radite. Na primer, ako radite s dijagramom,
Excelovi meniji se menjaju da bi vam pruzili opcije za rad s dijagramima. Sve se
odvija automatski, pa ne morate da razmisljate o tome. Meni ¢ete sasvim jednosta-
vno otvoriti — pritisnite miSem odgovarajuc¢i meni i bice prikazana lista opcija. Da
biste zadali komandu, pritisnite opciju menija.
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Slika 1-3: Kada pritisnete Excelov meni, dobijate pristup komandama koje saopstavaju
programu $ta Zelite da uradite.

Da biste zadali komandu s tastature, pritisnite taster Alt i vruci taster menija (engl. hot key,
podvuceno slovo u nazivu menija). Posto otvorite meni, pritisnite odgovarajuci vrudi taster
komande. Na primer, da biste zadali komandu File = Print, pritisnite Alt+F i onda P.

Neke stavke menija vode do dodatnih podmenija; kada miSem pritisnete stavku,
podmeni ¢e se pojaviti s njene desne strane. Pored stavki s podmenijem stoji mali
trougao. Na primer, komanda View = Toolbar ima podmeni (slika 1-3). Excelovi dizaj-
neri su ubacili podmenije prevashodno zato da meniji ne bi bili predugi i pretrpani.

Ponekad ce stavka menija biti prikazana bledo, §to znaci da ona ne odgovara
onome Sto u tom trenutku radite. Ako izaberete takvu stavku, niSta se nece desiti.

Stavke menija iza kojih slede tri tacke uvek prikazuju okvir za dijalog, a stavke
koje nemaju tacke izvrSavaju se odmah. Na primer, komanda File = Open daje okvir
za dijalog jer su Excelu potrebne dodatne informacije da bi je izvrsio. Komandi File &>
Print Preview ne treba okvir za dijalog — Excel je odmah izvrsava.

Liniju menija u Excelu moZete da premestite. Samo pritisnite par uspravnih sivih crta na

levoj strani linije menija i prevucite traku na drugo mesto. Traku mozZete prevuci do bilo

koje ivice prozora ili je ostaviti da slobodno pluta.

Kad pritisnete meni, moZe se desiti da se ne prikazu sve njegove stavke. U tom sluéaju, pri-
menjuje se opcija prilagodljivog menija (engl. adaptive menu), koju nikako ne prepo-
ru¢ujemo! Da biste je iskljuili, izaberite View > Toolbars => Customize. U okviru za dijalog
Customize otvorite karticu Options i potvrdite opciju Always Show Full Menus. Napomena
Microsoftu: momci, ovo je — bez svake sumnje — najbezveznija opcija koju ste nam ikad
ponudili!
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Poglavlje 1 ¢ Uvod u Excel )

Gotovo svaka komanda u Excelu moZe biti opozvana pomoc¢u komande Edit &> Undo. Izaberite
je ako ste zadali pogresnu komandu i sve ce biti kao pre. MozZete da ponistite efekat poslednjih
16 komandi koje ste izvrSili ako komandu Edit => Undo izaberete 16 puta.

Mozda ¢e vam vise odgovarati da umesto te komande koristite dugme Undo sa standardne
palete alatki. Ukoliko pritisnete strelicu na desnoj strani dugmeta, dobicete opis komandi koje
mozete da ponistite. Poslednju akciju mozete ponistiti i ako pritisnete precicu Ctrl+Z.

Dugme Redo obavlja suprotnu operaciju od komande Undo: ponovo izvrSava komande koje
su bile opozvane komandom Undo.

Upotreba priru¢nih menija

Pored uvek prisutne linije menija, Excel ima i mnostvo prirucnih menija (engl. short-
cut menu), koje moZete otvoriti kada desnim tasterom miSa pritisnete bilo gde u
prozoru Excela. Priru¢ni meniji nemaju sve komande koje se odnose na izabrani ele-
ment, ve¢ samo one Kkoje se najceSce koriste.

Primera radi, na slici 1-4 prikazan je priru¢ni meni koji se pojavljuje kad desnim
tasterom miSa pritisnete celiju. Meni se pojavljuje na mestu pokazivaca misa, pa je
biranje komandi brzo i efikasno. Priru¢ni meni zavisi od toga Sta je u tom trenutku
izabrano. Na primer, ako radite na dijagramu, priru¢ni meni - koji se prikazuje kada
desnim tasterom miSa pritisnete deo dijagrama — sadrZi komande koje pripadaju
izabranom elementu.

| r——— Slika 1-4: Pritisnite desni taster misa da
biste dobili priru¢ni meni s komandama
- koje se naj¢esce koriste.
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Upotreba precica s tastature
Pojedine stavke menija imaju precice s tastature. Na primer, komanda File => Save
ima precicu Ctrl+S. Dok budete radili u Excelu, otkri¢ete da precice mogu da vam
uStede dosta vremena.

Najbolji nacin da naucite precice jeste da ih posmatrate u menijima. Najkorisnije
precice su prikazane pored komandi kada otvorite meni.
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Upotreba paleta alatki

Excel ima praktic¢ne palete alatki koje pruzaju jo$ jedan nacin zadavanja komandi.
Na primer, dugme Copy na paleti alatki samo je zamena za komandu Edit => Copy.
Medutim, neka dugmad na paletama nemaju ekvivalentnu komandu menija. Primer
je dugme AutoSum, koje automatski ubacuje formulu za sabiranje podrucja Celija.
Da biste saznali koja je funkcija dugmeta, postavite pokaziva¢ miSa na njega (ali ga
ne pritiskajte). Pojavice se malo polje sa imenom dugmeta, Sto je najcesée dovoljno
da zakljucite dali je to dugme koje vam treba. Ako se ta polja ne prikazuju, izaberite
komandu Tools => Costumize. U okviru za dijalog Customize otvorite karticu Options

i potvrdite polje Show Screen Tips on Toolbars.
Tabela 1-3 sadrzi spisak najkorisnijih Excelovih ugradenih paleta alatki.

Tabela 1-3 Excelove ugradene palete alatki

Paleta Upotreba

Standard Zadavanje komandi koje se ¢esto koriste
Formatting Promena izgleda radnih listova ili dijagrama
Borders Dodavanje okvira oko izabranih oblasti
Chart Rad s dijagramima

Drawing Umetanje ili izmena crteza na radnom listu

Control Toolbox
Formula Auditing
Picture

Dodavanje kontrola (dugmadi, brojaca itd.) radnom listu
PronalaZenje gresaka na radnom listu
Umetanje ili obrada slika

PivotTable Rad sa izvedenim tabelama

Protection Kontrolisanje vrsta promena koje se mogu izvesti na radnom listu
Reviewing Alatke za koris¢enje radnih svezaka u grupama

Text to Speech Alatke za citanje sadrzaja celija

Web Alatke za pristup Internetu iz Excela

WordArt Umetanje ili izmena slike sastavljene od reci

Skrivanje i otkrivanje paleta alatki
Excel podrazumevano prikazuje dve palete alatki (Standard i Formatting). Vi potpuno
kontroliSete koje Ce se palete alatki prikazati i gde Ce se smestiti. Uz to, moZete da
napravite i sopstvene palete alatki, saCinjene od dugmadi koja su vama najkorisnija.
Da biste sakrili ili prikazali odredenu paletu, izaberite View = Toolbars ili priti-
snite desnim tasterom misa bilo koju paletu alatki. Obe akcije prikazace spisak samo
uobicCajenih paleta alatki (ne svih). Palete pored kojih stoji znak za potvrdu prika-
zane su na ekranu. Ako hocete da sakrijete paletu, uklonite znak za potvrdu pored
nje. Paletu cete prikazati ako unesete znak za potvrdu u odgovarajuce polje.
Da biste kontrolisali sve palete alatki, izaberite Tools = Customize. U okviru za
dijalog Customize pritisnite jeziCak kartice Toolbars da biste prikazali spisak svih
postojecih paleta alatki. Potvrdite polje pored palete alatki koju hocete da prikazete.

Premestanje paleta alatki

Palete alatki mogu se pomeriti na bilo koju od cCetiri strane Excelovog prozora ili
mogu slobodno da plutaju. Plutajuca (engl. floating) paleta moZe se pomerati po
celom ekranu. Veli¢ina palete se menja ako povlacite njene ivice. Da biste sakrili
plutajucu paletu, pritisnite njeno dugme za zatvaranje.
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Kada paleta alatki ne pluta slobodno, kaZe se da je usidrena. Usidrena paleta je smestena

uz samu ivicu Excelovog prozora i nema naslovnu traku, te joj se ne moze promeniti

veli¢ina.

Da biste premestili usidrenu paletu alatki, pritisnite uspravne sive crte na paleti
alatki i prevucite je miSem. Plutajucu paletu alatki cete premestiti ako pritisnete i
prevucete miSem njenu naslovnu traku. Ako je pomerite ka ivici prozora, ona ce se
tu automatski usidriti. Kad je paleta usidrena, ona izgleda kao jedan red ili kolona.

Rad sa okvirima za dijalog

Okviri za dijalog se pojavljuju kao odgovor na mnoge komande. Na primer, sve stavke
menija koje se zavrSavaju s tri tacke otvaraju okvir za dijalog. To je jednostavno Exce-
lov nacin da od vas dobije visSe podataka. Recimo, ako izaberete komandu View =
Zoom (koja menja uvecanje radnog lista), Excel ne moZe da je izvrsi dok od vas ne
sazna koliki stepen uvecanja Zelite.

Excelovi okviri za dijalog se razlikuju. Neki od njih mogu da ostanu na ekranu
dok radite (na primer, okvir za dijalog Find, koji se prikazuje kad izaberete komandu
Edit = Find). Medutim, vec¢ina Excelovih okvira za dijalog mora se zatvoriti pre nego
Sto nastavite s radom. Ako okvir zaklanja deo radnog lista koji vam je potreban,
pritisnite njegovu naslovnu traku i premestite ga.

Kad se okvir za dijalog prikaze, pomocu kontrola odabirate ono Sto vam treba.
Cim zavrsite, pritisnite OK (ili taster Enter) da biste nastavili s radom. Ako se pre-
domislite, pritisnite dugme Cancel (ili taster Esc) i niSta se nece dogoditi, kao da se
okvir nikad nije ni pojavio.

Kontrole okvira za dijalog
Vecdina ljudi smatra da je rad sa okvirima za dijalog sasvim pravolinijski i prirodan.
Ako ste radili u drugim programima, osecacete se kao kod kuce. Kontrolama moZete
upravljati ili miSem, ili direktno s tastature.

Na slici 1-5 prikazan je okvir za dijalog Print, koji sadrzi vec¢inu uobicajenih kon-
trola na koje moZete naici. U tabeli 1-4 opisane su te i joS neke kontrole drugih
okvira za dijalog.

Padajuca lista Polje za potvrdu Brojaé Slika 1-5: quoc’u
kontrola okvira za
dijalog unesite podatke
i kontrolisite okvir.
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Tabela 1-4 Uobicajene kontrole okvira za dijalog

Ime Opis

Dugmad Dugme je najjednostavnija kontrola. Samo ga pritisnite i obavice svoj zadatak. Ako
pritisnete Alt i podvuéeno slovo dugmeta, bice isto kao da ste pritisnuli dugme.

Dugmad za Dugmad za opcije se ponekad nazivaju radio-dugmad jer rade kao dugmad unapred

opcije podesenih radio-stanica na starim radio-aparatima i u automobilima. Kao i na njima,

(radio-dugmad) i ovde moze biti ,pritisnuto” samo jedno dugme. Kad pritisnete dugme opcije,
ponistava se izbor prethodnog dugmeta. Dugmad za opcije obi¢no su smestena
u posebne oblasti, a jedan okvir za dijalog moze imati vide takvih oblasti.

Polja za potvrdu Ovo je kontrola koja pokazuje da li je opcija uklju¢ena. Za razliku od dugmadi za
opcije, ova polja ne zavise jedna od drugih. Pritiskanjem polja naizmeni¢no postavljate
i uklanjate znak za potvrdu.

Polja za biranje  Ovo polje omogucava da izaberete oblast povlatenjem unutar radnog lista. U njemu
oblasti postoji malo dugme koje, kada ga pritisnete, ,sklapa” okvir za dijalog tako da vam
olak3a odabir oblasti unutar lista.

Brojaci Broja¢ olaksava zadavanje brojeva. Pritiskanjem strelica povecavate ili smanjujete
prikazanu vrednost. Broja¢ skoro uvek ide u paru s poljem za unos izmena. Vrednost
moZete upisati direktno u polje ili je podesiti pomocu strelica.

Polja sa listama Ova kontrola sadrZi listu iz koje birate opcije. Ako je lista duza od veli¢ine polja,
pregledajte je pomocu vertikalne klizne trake.

Padajuce liste  One su sli¢ne poljima sa listama, s tim to prikazuju samo jednu opciju. Kad pritisnete
strelicu na padajucoj listi, pojavljuje se spisak dodatnih opcija.

Kretanje u okvirima za dijalog
Kretanje po okviru za dijalog obic¢no je lako: samo pritisnete kontrole koje hocete da
aktivirate.

Iako su okviri dizajnirani za one koji se sluZze miSem, u istu svrhu moZete da kori-
stite i tastaturu. Svaka kontrola okvira za dijalog ima prateci tekst, koji uvek ima
jedno podvuceno slovo (vruci taster ili taster za precicu). Kad pritisnete taster Alt
i zatim podvuceno slovo, kontroli moZete pristupiti i s tastature. Takode, pomocu
tastera Tab moZete kruziti kroz sve kontrole u okviru za dijalog. Pomoc¢u kombi-
nacije Shift+Tab moZete kruZiti kroz kontrole u suprotnom smeru.

Kad izaberete kontrolu, oko nje se pojavljuje tamniji okvir. Da biste aktivirali izabranu kon-
trolu, mozZete upotrebiti razmaknicu.

Kretanje u okvirima za dijalog sa karticama
Mnogi Excelovi okviri za dijalog imaju kartice. To znaci da imaju jezicke kao u adre-
saru i svaki je povezan sa odgovarajuc¢om karticom. Kad pritisnete jezicak, pojavi
se odgovarajuca kartica s novim skupom kontrola. Dobar primer je okvir za dijalog
Options, koji se pojavljuje posle komande Tools = Options. On je prikazan na slici
1-6; ima 13 kartica, Sto je isto kao da imamo 13 okvira za dijalog.

Okviri za dijalog sa karticama vrlo su prakti¢ni jer moZete da promenite viSe
opcija na jednom mestu. Kad zavrsite, pritisnite dugme OK ili taster Enter.

Da biste izabrali karticu preko tastature, koristite kombinaciju tastera Ctrl+PgUp ili
Ctrl+PgDn, ili samo pritisnite prvo slovo imena kartice koju hocete da aktivirate.
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Kartice  Slika 1-6: Pomocu kartica
u okviru za dijalog birate
razli¢ite funkcionalne

oblasti.
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Excel je izuzetno fleksibilan program, s brojnim opcijama kojima mozete podesiti njegov rad i
izgled. Medutim, problem je u pronalazenju tih opcija.

Okvir za dijalog Options podseca na neurednu fioku, kojoj dizajneri u svakoj novoj verziji pro-
grama uporno dodaju nove opcije. Stoga bi, u konkurenciji loseg dizajna korisnickog okruzenja,
ovaj okvir lako mogao da osvoji prvo mesto.

U Excelu radim viSe od deset godina. Kad god otvorim okvir za dijalog Options, nikad ne znam
koju karticu da upotrebim (obi¢no isprobam dve ili tri dok ne pronadem ono $to mi treba). Medu-
tim, osnovni problem ovog okvira za dijalog jeste nedoslednost. Neke opcije se odnose samo na
aktivne radne listove, neke na sve, a rasute su svuda, bez jasnog obeleZja koja se za $ta koristi.

Da stvar bude gora, pomocu dugmadi okvira Options mozete videti i druge okvire za dijalog,
sa dodatnim opcijama. Prekopajte malo okolo i videcete koliko ih ima.

Ali ni to nije sve! Ne zaboravimo na okvir za dijalog Customize (Tools => Customize), sa jo$
viSe opcija kojima ne mozete pristupiti preko okvira za dijalog Options. Nisam zavrSio: kad sni-
mate radnu svesku, okvir za dijalog Save As vodi do dodatnih opcija, kojima mozZete pristupiti
preko menija Tools unutar okvira za dijalog. Siguran sam da vecina Excelovih korisnika nikada ne
bi nasla ovaj okvir za dijalog, ¢ak i kad bi znala sta trazi.

Mi, veterani, viemenom smo navikli na sve uzase novih korisnickih okruzenja, pa smo skloni
da ih prihvatimo zdravo za gotovo. Medutim, iskreno saose¢am sa manje iskusnim korisnicima,
koji — u Zelji da promene samo nekoliko stvari — upadaju u neocekivane avanture koje se ne
zavrSavaju uvek uspesno.

U svakoj novoj verziji Excela Microsoft dobija $ansu da ras¢isti ovu zbrku, a sasvim je izvesno
da ima i nacine za to. Umesto toga, on i dalje — bez ikakvog reda — gura nove stvari u svoje
neuredne fioke.
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14 Deo | ¢ Pocetak rada u Excelu

Primer: izrada radnog lista
U ovom poglavlju moci ¢ete da provezbate rad u Excelu na prakti¢nom primeru:
napravicete jednostavnu tabelu predvidenih mesecnih prihoda i odgovarajudi dija-
gram. Ako ranije niste koristili Excel, pratite naSa uputstva radeci na racunaru i tako
cete najbolje steci osecaj kako funkcioniSe ovaj program.

Pocetak izrade radnog lista
Pokrenite Excel pomo¢u Windowsovog dugmeta Start. Prikazace se prazna radna
sveska.

Podaci o predvidenim prihodima nalazice se u tabeli s dve kolone. U koloni A
bic¢e nazivi meseci u godini, a u koloni B iznosi predvidenih prihoda. Najpre unesite
zaglavlje radnog lista, i to na sledeci nacin:

1. Postavite pokazivac na Celiju A1 pomocu tastera sa strelicama. U polju za ime
prikazace se adresa Celije.

2. U celiju A1 upiSite Mesec i nakon toga pritisnite Enter. Zavisno od toga kako je
Excel podeSen, pokazivac ce se ili premestiti na drugu celiju ili ¢e ostati na
Celiji Al.

3. Pomerite pokazivac na celiju B1, upiSite Predvideni prihodi i pritisnite Enter.

Upis imena meseci
U ovom koraku upisacete imena meseci u kolonu A.

1. Pomerite pokazivac na celiju A2 i za mesec januar unesite jan.

Umesto da ru¢no popunite celije skracenim nazivima preostalih meseci, isko-
ristite Excelovu funkciju AutoFill, koja ce to uraditi automatski.

2. Proverite da li je aktivna Celija A2. Obratite paZnju na to da se aktivna celija
prikazuje s tamnim okvirom, u Cijem se donjem desnom uglu nalazi mali kva-
drat koji se zove rucica za automatsko popunjavanje (engl. fill handle). Pome-
rite pokaziva¢ miSa na rucicu, pritisnite je i povucite sve dok ne izaberete
Celije od A2 do A13. Otpustite taster miSa i Excel ¢e automatski popuniti iza-
brane celije nazivima meseci.

Vas radni list trebalo bi da izgleda kao na slici 1-7.
Slika 1-7: Radni list nakon

Sto ste upisali zaglavlja
kolona i nazive meseci.
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Poglavlje 1 ¢ Uvod u Excel 15

Upis podataka o prihodima
Pretpostavimo da je planiran januarski prihod 50.000 evra, sa rastom od 2,5% u sva-
kom narednom mesecu.

1. Pomerite pokazivac na celiju B2 i upisite 50.000,00 €, Sto ce predstavljati
predvideni prihod za januar. Ukoliko u vasem slucaju nije rec o evrima,
moZete znak za valutu izostaviti ili zameniti nekim drugim simbolom.

2. Da biste uneli formulu za izracunavanje predvidenih prihoda za februar,
pomerite pokazivacC na Celiju B3 i upiSite =B2*102,5%. Kad pritisnete Enter,
u Celiji ¢e se prikazati 51.250,00 €, 5to znaci da je u formuli pomnoZena vred-
nost Celije B2 sa 102,5%. Drugim reCima, predvida se da ¢e februarski prihod
biti veéi od januarskog za 2,5%.

3. Predvideni prihodi u narednim mesecima izracunavace se pomocu sli¢ne for-
mule. Da ne biste formulu ru¢no upisivali u svaku celiju kolone B, opet upo-
trebite funkciju AutoFill. Proverite da li je aktivna celija B3. Pritisnite miSem
njenu rucicu za automatsko popunjavanje, povucite do ¢elije B13 i otpustite
taster misa.

Sada bi vas radni list trebalo da izgleda kao na slici 1-8. Imajte na umu da se, osim
u sluc€aju Celije B2, vrednosti kolone B izracunavaju pomocu formula. Primera radi,
izmenite predvidenu vrednost za januar (u celiji B2). Videcete da ce rezultati for-
mula biti drugaciji jer sve one zavise od vrednosti Celije B2.

Slika 1-8: Radni list nakon
unosenja formula.
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Sabiranje vrednosti
Radni list prikazuje predvidene mesecne prihode, ali Sta je sa ukupnim godiSnjim
prihodima? Za to nam treba nova formula.

1. Pomerite se na celiju A14 i upiSite Ukupno.

2. Pomerite se na celiju B14, prvu praznu celiju ispod podataka o prihodima.

3. Pronadite dugme AutoSum na paleti Standard (dugme sa grckim slovom

sigma).
4. Pritisnite dugme AutoSum pa taster Enter.
Excel ée nakon toga u ¢eliju B14 dodati formulu =SUM(B2:B13), koja izraCunava

zbir vrednosti €elija (od B2 do B13) i prikazuje rezultat. Ovu formulu ste mogli da
upiSete i sami, ali pomoc¢u dugmeta AutoSum brZe cete dobiti rezultat.
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16 Deo | ¢ Poéetak rada u Excelu

Podesavanje radnog lista
Imate radni list koji radi ono Sto treba i sada biste mogli malo da ga doterate.

1

. Najpre dodajte naslov iznad tabele. Pritisnite celiju Al i izaberite Insert =

Rows, Cime ¢ete umetnuti jedan nov red. Ako hocete jos jedan prazan red,
ponovo zadajte ovu komandu.

Obratite paZnju na to da se postojeci podaci pomeraju nadole da bi napravili
mesto za nove redove. Ako proverite formule, videcete da one i dalje
ispravno rade — Excel podeS§ava reference na celije, kao Sto ste i ocekivali.

. Pomerite pokazivac na celiju Al i upiSite Predvideni prihodi.
. Da bi se naslov isticao u odnosu na ostale podatke, pritisnite ¢eliju Al i zatim

dugme Bold na paleti Formatting (dugme sa slovom B). Nakon toga povecajte
font na, recimo, 14 tacaka. Kontrola veli¢ine fonta nalazi se levo od dugmeta
Bold.

. Mogli biste da isprobate i druge formate na tabeli, ali pusticemo ipak Excel da

radi sam. Pritisnite bilo koju €eliju — na primer, B3. Koju éete celiju izabrati
nije bitno, jer ¢e Excel sam odrediti granice tabele. Nemojte samo da pritis-
nete celije u prvom ili drugom redu jer se nalaze izvan tabele (tabela sada
pocinje u tre¢em redu zbog redova koji su dodati u prvom koraku).

. Pritisnite meni Format i izaberite opciju AutoFormat. Excel ¢e odrediti gra-

nice tabele, izabrati celu tabelu i prikazati okvir za dijalog AutoFormat.

. Ovaj okvir sadrzi 16 gotovih formata (plus opciju None kojom uklanjate svako

formatiranje). Izaberite odgovarajuci format.

. Pritisnite dugme OK i Excel ¢e primeniti format na tabelu.
. Ako vam se ne svida rezultat koji ste dobili, izaberite komandu Edit = Undo da

biste vratili radni list u stanje pre automatskog formatiranja, a moZete i ponovo
upotrebiti komandu Format = AutoFormat da biste isprobali neku drugu
opciju. Posto se u tabeli nalaze i oznake za valutu, mozZda cete Zeleti da prime-
nite automatsko formatiranje koje prikazuje dva decimalna mesta ili nijedno.

Izrada dijagrama
Napravite sada dijagram koji ¢e prikazivati predvidene prihode za svaki mesec.

1

. [zaberite podatak koji treba da se prikaZe na dijagramu: pritisnite celiju A3, a

zatim povucite nadole i udesno da biste ukljucili u izbor i ¢eliju B15. Obratite
paznju na to da red sa sumarnim podacima (red 16) nije izabran.

. Pritisnite dugme Chart Wizard na paleti Standard (dugme sa slikom stubi-

Castog dijagrama).

. Prikazace se okvir za dijalog Chart Wizard (slika 1-9).
. Sa liste Chart Type izaberite opciju Column i prikazace se sedam podtipova

dijagrama.

. Podrazumevani podtip deluje prihvatljivo, pa pritisnite dugme Finish da biste

napravili dijagram.

Excel smesta dijagram na sredinu ekrana. Vi ga moZete premestiti, Cak izmeniti i
njegovu veli¢inu ili proporcije (pritiskanjem okvira dijagrama i povlacenjem pomocu
miSa). Dijagram moZete menjati i na druge nacine: na primer, mozda cete Zeleti da
uklonite legendu. Da biste to uradili, pritisnite legendu pa taster Del.
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dijalog Chart Wizard.
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Slika 1-10: Radna lista nakon izrade dijagrama.
Na (:D-‘|
-.‘..ﬂ Ova radna sveska se mozZe naci na pratecem CD-u.
.

Stampanje radnog lista
Stampanje radnih listova u Excelu veoma je jednostavno (pod uslovom da imate
ispravan Stampac povezan s racunarom). Bilo bi dobro da napravite prikaz pre
Stampanja.
1. Dijagram ne treba da bude izabran - ako jeste, pritisnite taster Esc ili bilo
koju €eliju da biste ponistili izbor.
2. Pritisnite dugme Preview na paleti Standard. Excel ¢e otvoriti nov prozor
i dati prikaz radnog lista pre Stampanja.
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18 Deo | ¢ Poéetak rada u Excelu

3. Pritisnite dugme Close da biste se vratili u radni list.
4. Ako ste zadovoljni izgledom radnog lista, pritisnite dugme Print na paleti
Standard (dugme sa sli¢icom Stampaca). Radni list ¢e se odStampati prema
- podrazumevanim parametrima.

Napomena Mozda Cete Zeleti da podesite veli¢inu ili poloZaj dijagrama da bi mogao ceo da stane na
jednu stranicu.

Snimanje radnog lista

Sve §to ste dosad radili desavalo se u memoriji racunara. Ako bi nestalo struje, sve
bi bilo izgubljeno — osim ako ne bi reagovala Excelova funkcija AutoRecover. Vreme
je da ono §to ste uradili snimite u datoteku na disku.

1. Pritisnite dugme Save na paleti Standard (dugme sa sliCicom diskete). Excel
Ce prikazati okvir za dijalog Save As.

2. U polje File Name upiSite Predvideni mesecni prihodi, a zatim pritisnite
dugme Save ili taster Enter.
Excel snima radnu svesku kao datoteku na disku. Radna sveska ostaje

- otvorena da biste mogli i dalje da radite s njom.

Napomena Excel podrazumevano snima ono 3to ste radili svakih deset minuta. Da biste to promenili

(ili iskljucili), upotrebite okvir za dijalog Options (izaberite komandu Edit => Undo i priti-
snite jezicak kartice Save).

Naravno, do sada ste samo zagrebali povrSinu. U ostatku knjige, ovi zadaci (kao
i mnogi drugi) bi¢e objasnjeni s mnogo viSe detalja.
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